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1 Welcome

Thank you for choosing the WorkCentre 4118 / FaxCentre 2218. These products have been
designed for ease of use, but to use your machine to its fullest potential take some time to read the

User Guide.

vV VYV VYV V

Introduction . . .......... . . ...
About ThisGuide. ... ... ... .. . . ... . ....
Related Information Sources. . .. .............

Customer Support. .......... ... .. ...
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Welcome

Introduction

The WorkCentre 4118 / FaxCentre 2218 are digital devices capable of being used for faxing,
copying, printing and scanning. The features and functions available on your machine depend
on the model purchased.

WorkCentre 4118 Series

2inl

This model provides digital copying and direct printing at 17 pages per minute A4 or 18 pages
per minute letter as standard.

Options available include an additional Paper Tray, Document Feeder, Foreign Interface,
Stand and the Network Kit. The Network Kit enables network printing, including a driver
compatible with PostScript®3™. The kit also includes Macintosh and Linux print and scan
drivers.

4in 1l
The 4 in 1 model provides digital copying, direct printing, fax and direct scanning at 17/18

pages per minute.

Options include an additional Paper Tray, Foreign Interface, Stand and the Network Kit. The
Network Kit enables network printing, including a driver compatible with PostScript®3TM. The
kit also includes Macintosh and Linux print and scan drivers.

FaxCentre 2218

Provides faxing, digital copying, direct printing and scanning at 17 pages per minute A4 or 18
pages per minute letter as standard.

Options include an additional Paper Tray, Foreign Interface, Stand and the Network Kit. The
Network Kit enables network printing, including a driver compatible with PostScript®3™. The
kit also includes Macintosh and Linux print and scan drivers.
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About This Guide

Throughout this System Administration Guide some terms are used interchangeably:

> Paper is synonymous with media.

» Document is synonymous with original.

> Page is synonymous with sheet.

> WorkCentre 4118 / FaxCentre 2218 is synonymous with the machine.

The following table offers further information about the conventions used within this Guide.

CONVENTION

DESCRIPTION

EXAMPLE

Italic Typeface

Used to emphasize a word or
phrase. In addition, references to
other publications are displayed in
Italic typeface.

WorkCentre 4118 / FaxCentre
2218.

Bracket Text Typeface

Used to emphasize the selection
of a feature mode or button.

> Select the paper supply source
required by pressing [Paper
Supply].

Notes

Located in the margins and used
to provide additional or useful
information about a function or
feature.

e For instructions on loading media,
refer to “Loading Paper” in the User
Guide.

Specification Note

Provides more in-depth
specification information relating to
the machine.

@  For full media specifications refer
to “Media Specifications” in the
User Guide

possibility of personal injury.

Caution Cautions are statements that -
. CAUTION: DO NOT use organic
suggest mechanical damage as a .
It of ) or strong chemical solvents or
resuit of an action. aerosol cleaners or pour fluids
directly onto any area.
Warning Used to alert users to the

WARNING: This product must
be connected to a protective
grounded circuit.

Xerox WorkCentre 4118 and FaxCentre 2218 System Administration Guide
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Welcome

Related Information Sources

Information available for the products consists of:

- This System Administration Guide
- The Quick Use Guide

- The Quick Install Sheets

- The User Guide

- The Xerox website www.xerox.com
- The Network Quick Setup Guide

- The Reference Poster
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Customer Support

If you need assistance during or after product installation, please visit the Xerox website for
online solutions and support:

http://www.xerox.com

If you require further assistance, call our experts at the Xerox Welcome Center, or contact your
local representative. When telephoning please quote the machine serial number. Use the
space below to make a note of the machine serial number:

#

To access the serial number open the side cover using the release latch and then open the
front door. The serial number is located on the panel above the Toner Cartridge.

The Xerox Welcome Center or local representative telephone number is provided when the
machine is installed. For convenience and future reference, please record the telephone

number in the space below:

#
Xerox US Welcome Center: 1-800-821-2797
Xerox Canada Welcome Center: 1-800-93-XEROX (1-800-939-3769)

Xerox WorkCentre 4118 and FaxCentre 2218 System Administration Guide Page 1-5
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2 Basic Network Installation

Introduction

This chapter explains how to make the basic settings to install the WorkCentre 4118 / FaxCentre
2218 on a network. The physical connection is Ethernet and the addressing protocols are provided
by TCP/IP. The following information is provided:

» Information Checklist. ... ................... 2-2
> EthernetPort.......... .. .. . . . . . . . .. . . .... 2-3
> BasicTCP/IP Settings. . .......... ... 2-5
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Basic Network Installation

Information Checklist

Before starting the basic network installation procedures, please ensure the following items

are available or have been performed:

Item By
An existing operational network utilizing TCP/IP is required, these Customer
procedures are not designed to install a network.
A suitable network cable. Customer
If you are going to configure TCP/IP manually, you need to obtain and | Customer
record the following information:
e TCP/IP Address:
e Gateway Address:
e Subnet Mask Address:
e Primary DNS Server Address:
Refer to the Glossary for additional information on the Gateway
Address, Subnet Mask Address and Primary DNS, if needed.
Test the WorkCentre 4118 / FaxCentre 2218 to ensure it is installed Customer

fully and functioning correctly.

WorkCentre 4118 / FaxCentre 2218 print drivers.

Xerox

If problems are encountered during the WorkCentre 4118 / FaxCentre 2218 installation, refer

to the Problem Solving chapter for assistance.

CAUTION: Do not connect the network cable to the WorkCentre 4118 / FaxCentre

2218 until instructed to do so.

Page 2-2
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Ethernet Port

The Ethernet port is the default interface used on the WorkCentre 4118 / FaxCentre 2218.

NOTE: The Ethernet port cannot be disabled.

Ethernet Port Setup
If the speed setting of the Ethernet port needs to be changed perform the following steps:

0 » Connect the device to the network outlet or cable.

> Press the [Machine Status]
button.

—Machine Setup
Fax Setup
@ > Press ¥ or A until System

Admin Tools displays and press

[Enter]. System Admin Tools

> If the System Admin Tools have [Passcode Protect]
been passcode protected, type in
the password and press [Enter].

> Press <« or » until Network
Setup displays and press [Enter].

System Admin Tools
[Network Setup]

Xerox WorkCentre 4118 and FaxCentre 2218 System Administration Guide Page 2-3
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Basic Network Installation

@ > Press <€ or » until Configure
Network displays and press

[Enter]. Network Setup
[Config. Network]

> Press <€ or » until Ethernet
displays and press [Enter].

Config. Network
[Ethernet]

0 > Press [Enter] to set the speed.
Ethernet
[Speed]

> Press <€ or » to display the
appropriate speed and press
[Enter].

The choices are:

Auto

10M Half
10M Full
100M Half
100M Full

@ > Setup the TCP/IP addresses (see “Basic TCP/IP Settings” on page 2-5).

Page 2-4
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Basic TCP/IP Settings

Before the printer can be used on the network, the TCP/IP addresses need to be entered.
These can be entered automatically using Dynamic Host Configuration Protocol (DHCP) or
Bootstrap Protocol (BOOTP) or entered manually. To enter the addresses manually, you need
to obtain the following:

» TCP/IP Address

> Gateway Address

» Subnet Mask Address

> Primary DNS Server Address

Installation Procedure
There are three stages required to install the WorkCentre 4118 / FaxCentre 2218 in a TCP/IP
networking environment:
> Network Communication Setup
This requires the WorkCentre 4118 / FaxCentre 2218 to be setup for TCP/IP.
> Workstation Setup

This requires the workstations in the networking environment to be
configured to communicate with the WorkCentre 4118 / FaxCentre 2218.

» Test Print

A print job should be submitted to ensure the WorkCentre 4118 / FaxCentre
2218 has been installed and configured correctly.

Xerox WorkCentre 4118 and FaxCentre 2218 System Administration Guide Page 2-5
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Basic Network Installation

Enabling or Disabling TCP/IP

At the WorkCentre 4118 / FaxCentre 2218, perform these steps:

> Press the [Machine Status]
button.

—Machine Setup
Fax Setup

@ > Press Y or A untl System

Admin Tools displays and press
[Enter].

System Admin Tools
> If the System Admin Tools have [Passcode Protect]
been passcode protected, type in

the password and press [Enter].

> Press <€ or » until Network
Setup displays and press [Enter].

System Admin Tools
[Network Setup]

9 > Press <€ or » until Configure

Network displays and press
[Enter].

Network Setup
[Config. Network]
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> Press <€ or » until TCP/IP
displays and press [Enter].

Config Network
[TCP/IP]

@ > Press <€ or » until Setup

displays and press [Enter].

> To enable TCP/IP, press <« or TCP/IP
» until Enable displays and [Setup]
press [Enter]. Otherwise select
Disable and press [Enter].

Network Communication Setup

Automatically setting TCP/IP Addresses
At the WorkCentre 4118 / FaxCentre 2218, perform these steps:

0 > Ensure the Ethernet Port has been configured (see “Ethernet Port” on page 2-3).

> Press the [Machine Status]
button.

—Machine Setup
Fax Setup
@ > Press Y or A until System

Admin Tools displays and press

[Enter]. System Admin Tools

> If the System Admin Tools have [Passcode Protect]
been passcode protected, type in
the password and press [Enter].

Xerox WorkCentre 4118 and FaxCentre 2218 System Administration Guide Page 2-7
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Basic Network Installation

> Press <€ or » until Network
Setup displays and press [Enter].

System Admin Tools
[Network Setup]

@ > Press <€ or » until Configure
Network displays and press

[Enter]. Network Setup
[Config. Network]
@ > Press <« or » until TCP/IP

displays and press [Enter].

You can use DHCP or BOOTP to Config Network
automatically configure TCP/IP [TCP/I1P]

on the machine.

0 » Press <« or » until the

required setting method displays

and press [Enter]. TCP/IP
[DHCP]

After a short period of time, the network will allocate the required addresses.

@ Print a System Data sheet to check the addresses (see the User Guide for printing reports).

Page 2-8
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Manually setting TCP/IP Addresses
At the WorkCentre 4118 / FaxCentre 2218, perform these steps:

HINT: Xerox CentreWare Internet Services can also be used to configure the WorkCentre
4118 / FaxCentre 2218, refer to the CentreWare Internet Services chapter for instructions.

When manually making the TCP/IP settings, you will need to know the following information:
> The IP address.

> The subnet mask, if required.

> The Gateway address, if required

> The primary and Secondary DNS address, if required.

0 > Ensure the Ethernet Port has been configured (see “Ethernet Port” on page 2-3).

> Press the [Machine Status]
button.

—Machine Setup
Fax Setup
@ > Press ¥ or A until System

Admin Tools displays and press
[Enter].

System Admin Tools
> If the System Admin Tools have [Passcode Protect]

been passcode protected, type in
the password and press [Enter].

> Press <€ or » until Network
Setup displays and press [Enter].

System Admin Tools
[Network Setup]

Xerox WorkCentre 4118 and FaxCentre 2218 System Administration Guide Page 2-9
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Basic Network Installation

@ > Press <€ or P until Configure
Network displays and press

[Enter].

> Press < or » until TCP/IP
displays and press [Enter].

> Press <€ or » until Manual
displays and press [Enter].

@ > For each address, press <« or
» until the required setting

displays and press [Enter].

Network Setup
[Config. Network]

Config Network
[TCP/IP]

Config Network
[Manual]

Manual
[IP Address]

Page 2-10
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@ > Enter the address using the

keypad and press [Enter].

Press the » to move IP Address
between fields, use <« to XXX 2 XXX 2 XXX 2 XXX

correct mistakes.

NOTE: If required, subnet mask, Gateway address and DNS address can be set up using
the same steps.

@ > Continue with Workstation Setup on page 2-12.

Xerox WorkCentre 4118 and FaxCentre 2218 System Administration Guide Page 2-11
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Basic Network Installation

Workstation Setup

To enable the workstation environment to communicate with the WorkCentre 4118 /
FaxCentre 2218 perform the following steps:

0 > At the client workstation, install print drivers and map to the printer (see Workstation Setup
4-3).

@ » Continue with Test Print, see Test Print 8-16.
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3 NetWare

Introduction

This chapter explains how to install the WorkCentre 4118 / FaxCentre 2218 on the various
NetWare networks. The following information is provided:

» Information Checklist. ... ................... 3-2
> NetWare Environments . ... ................. 3-3
> IPNDPSPrinting.................. ... ..... 3-4
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NetWare

Information Checklist

Before starting the NetWare installation procedures, please ensure the following items are

available or have been performed:

Item By
An existing operational NetWare network is required, these Customer
procedures are not designed to install a NetWare network.
NetWare client, server and operating system software version 4.x, 5.x | Customer
and 6.x.
Install the printer drivers on each workstation that will use the printer. | Customer
Ensure LPR is enabled on the WorkCentre 4118 / FaxCentre 2218. Customer
Refer to “Enabling/Disabling LPR/LPD” on page 6-3 for configuration
instructions.
Test the WorkCentre 4118 / FaxCentre 2218 to ensure it is installed Customer

fully and functioning correctly.

WorkCentre 4118 / FaxCentre 2218 print and fax drivers.

Xerox

Xerox NDPS Gateway.

Xerox

If problems are encountered during the WorkCentre 4118 / FaxCentre 2218 installation, refer

to the Problem Solving chapter for assistance.

Page 3-2
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NetWare Environments

Novell NetWare is supported by installing Novell Distributed Printing System (NDPS) over IP
networks using the LPR protocol.

The NetWare versions and protocols supported in this chapter are as follows:
> NetWare Versions supported:

NetWare 4.x, 5.x and 6.x
> Network Protocols supported:

IP (IP printing is supported via LPR/LPD only)

NetWare

Xerox WorkCentre 4118 and FaxCentre 2218 System Administration Guide Page 3-3



NetWare

IP NDPS Printing

> Ensure server(s) and NDS are patched to the correct level.
» Ensure NDPS 2.0 is installed.
> Ensure the latest version of the Xerox NDPS Gateway is installed on the relevant server.

> Ensure you have an NDS login with sufficient rights to create objects in the required
container.

NDPS Printing to the WorkCentre 4118 / FaxCentre 2218 uses IP and LPR printing therefore
the Line Printer Daemon must be configured. See “Enabling/Disabling LPR/LPD” on page 6-3.

0 > Create NDPS Printer object:
In NDS create a new NDPS Printer object in the appropriate container.
- Enter a name and select [Create].

- Choose the appropriate NDPS Manager and select the Novell Printer Gateway.
Select [OK].

- You can choose a printer type at this stage if required. Otherwise leave as
None. Select [OK].

- On the Configure Port Handler screen select [LPR on IP] and then select [Next].

- Enter the IP Address (or host name if appropriate) of the WorkCentre 4118 /
FaxCentre 2218.

NOTE: The Printer Name can be left at the default.

- Select [Finish]. The new Printer Agent will load on the relevant server.

- You can select print drivers at this point if you wish. Select [Continue] and then
[OK] to finish.

NOTE: The two configurations described above can coexist.

@ > Install the print driver on each workstation (see “Workstation Setup” on page 4-3).
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4 Print Driver Installation for
Networked Printers

Introduction

This chapter explains how to install the print drivers for networked printers. The following
information is provided:

» Information Checklist. ... ................... 4-2
> Workstation Setup. .......... ... ... . . 4-3
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Print Driver Installation for Networked Printers

Information Checklist

Before starting the driver installation procedures, please ensure the following items are
available or have been performed:

Item By

The printer has been installed on the network. Customer

WorkCentre 4118 / FaxCentre 2218 print drivers are available on CD. | Xerox

If problems are encountered during the WorkCentre 4118 / FaxCentre 2218 installation, refer
to the Problem Solving chapter for assistance.
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Workstation Setup

1

This section includes the setup procedures for the various workstation environments.

Locate and perform the workstation setup procedures for the workstation environment.

Choose from:

> Windows XP (TCP/IP) (see 4-4).

> Windows 2000 (TCP/IP) (see 4-5).

> Windows NT V4.0 (TCP/IP) (see 4-7).

> Windows 98/Millennium Edition (TCP/IP) (see 4-8).
> Windows XP (IPP) (see 4-9).

> Windows 2000 (IPP) (see 4-10).

> Apple Mac OSX with Bonjour (see 4-11).

> Apple Mac OSX with AppleTalk (see 4-12).

> Apple Mac OSX with IPP (see 4-13).

» Linux

NOTE: Ensure you have the correct drivers CD (part number 705N00017 for PCL or
705N00021 for the driver compatible with PostScript®3™) prior to starting the above
procedures.

» Continue with Test Print, see Test Print 8-16.

Xerox WorkCentre 4118 and FaxCentre 2218 System Administration Guide
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Print Driver Installation for Networked Printers

Windows XP (TCP/IP)

® O

4

NOTE: Windows XP supports printing via TCP/IP as standard when TCP/IP is installed on a
Windows XP Workstation.

Ensure you have the correct drivers CD (part number 705N00017 for PCL or 705N00021 for
the driver compatible with PostScript®3™) prior to starting this procedure.

Use the Add Printer Wizard to add the WorkCentre 4118 / FaxCentre 2218 to the network.

> Select [Start], select [Printers and Faxes].

Double-click on the [Add Printer] icon to display the Add Printer Wizard and select [Next].

> Select [Local Printer attached to this computer], uncheck the box labelled [Automatically
detect and install my Plug and Play printer] and then select [Next] to display the dialog box
listing available ports.

> Select [Create a new port].

Select [Standard TCP/IP Port] and select [Next] to display the Add Standard TCP/IP
Printer Port dialog box and select [Next].

Enter the IP Address of the printer in the [Name or address of printer] field (you can
optionally enter a friendly name for the printer port you are creating or use the default
name created). Then select [Next] to continue.

If the network printer settings are not automatically detected, click on the [Custom] button
to setup the network printer port settings, then select [Finish].

It is recommended that you select [RAW] as the Print Protocol.
If you prefer to use LPR:

Select [LPR] as the Print Protocol.

Enter [Ip] (in lower case) in the [LPR queue name] field.
Uncheck the box labeled [LPR Byte Counting Enabled].
Check the box labeled [SNMP Status Enabled].

The [Community Name] should normally be set to public (unless you have configured the
device to have a custom SNMP community name) and the [SNMP Device Index] should
be setto 1.

Select [OK].

> The Add Printer Wizard will then request that you select the driver to be used for this
printer.

Page 4-4
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6

Insert the CD containing the WorkCentre 4118 / FaxCentre 2218 drivers and select [Have
Disk].

Browse to the required Windows XP driver on the CD and select [OK].

NOTE: The driver will be found in the Drivers>Print folder on the CD in the appropriate PCL
or PostScript®3TM (PS) folder. The driver is identified by the file extension .inf.

Select [Next], and select [Next] again and the WorkCentre 4118 / FaxCentre 2218 driver
will be loaded onto the workstation.

Enter the Printer Name and select [Next].

> If you wish to share the printer over the network select [Shared]. You may also wish to
install printer drivers for other operating systems that will access the printer.

A dialog box displays with a message regarding the printing of a test page.

Select [Finish] to accept the Yes choice.

» Continue with Test Print, see Test Print 8-16.

Windows 2000 (TCP/IP)

dO @

NOTE: Windows 2000 supports printing via TCP/IP as standard when TCP/IP is installed on
a Windows 2000 Workstation.

Use the Add Printer Wizard to add the WorkCentre 4118 / FaxCentre 2218 to the network.

> Select [Start], select [Settings], and then select [Printers].
Double-click on the [Add Printer] icon to display the Add Printer Wizard.
> Select [Local Printer], uncheck the box labelled [Automatically detect and install my Plug
and Play printer.] and then select [Next] to display the dialog box listing available ports.
> Select [Create a new port] to display the Printer Ports dialog box.

Select [Standard TCP/IP Port] and select [Next] to display the Add Standard TCP/IP Port
dialog box.

Enter the IP Address of the printer in the [Name or address of printer] field (you can
optionally enter a friendly name for the printer port you are creating or use the default
name created). Then select [Next] to continue.
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Print Driver Installation for Networked Printers

If the network printer settings are not automatically detected, click on the [Custom] button
to setup the network printer port settings.

It is recommended that you select [RAW] as the Print Protocol.
If you prefer to use LPR:

Select [LPR] as the Print Protocol.

Enter Ip (in lower case) in the [LPR print queue] field.

Uncheck the box labelled [LPR Byte Counting Enabled].
Check the box labelled [SNMP Status Enabled].

The [Community Name] should normally be set to public (unless you have configured the
device to have a custom SNMP community name) and the [SNMP Device Index] should
be setto 1.

Select [OK].

> The Add Printer Wizard will then request that you select the driver to be used for this
printer.

Insert the CD containing the WorkCentre 4118 / FaxCentre 2218 drivers and select [Have
Disk].

Browse to the required Windows 2000 driver on the CD and select [OK].

NOTE: The driver will be found on the appropriate PCL or PS CD, in the
Drivers>Print>ADDPrint folder. You will need to select the required language and operating
system. The driver is identified by the file extension .inf.

Select [Next], and select [Next] again and the WorkCentre 4118 / FaxCentre 2218 driver
will be loaded onto the workstation.

Enter the Printer Name and select [Next].

> If you wish to share the printer over the network select [Shared]. You may also wish to
install printer drivers for other operating systems that will access the printer.

A dialog box displays with a message regarding the printing of a test page.

Select [Finish] to accept the Yes choice.

» Continue with Test Print, see Test Print 8-16.
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Windows NT V4.0 (TCP/IP)

NOTE: TCP/IP Print Services must be installed and running on the workstation.

Use the Add Printer Wizard to add the WorkCentre 4118 / FaxCentre 2218 to the network.

0 > At the Windows NT workstation, select [Start], select [Settings], and then select [Control
Panel].

Double-click on the [Network] icon and then select [Services].

Ensure Microsoft TCP/IP Print Service is running and select [Start], select [Settings], and
then select [Printers].

Double-click on the [Add Printer] icon to display the Add Printer Wizard.

> Select [My Computer] and then select [Next] to display the dialog box listing available
@ ports.
Select [Add Port] to display the Printer Ports dialog box.

Select [LPR Port] and select [New Port] to display the Add LPR compatible printer dialog
box.

@ > Enter the IP Address of the printer in the [Name or address of server providing Ipd] field.

Enter Ip (in lower case) in the [Name of printer or print queue on that server] field.

Print Driver Installation for Networked Printers

NOTE: Ip must be entered regardless of the name of the printer or print queue. Ip is the
name of the remote printer/server on the WorkCentre 4118 / FaxCentre 2218. This name
does not change.

Select [OK].

Select [Close].

9 > With the New Port selected, select [Next].

Insert the CD containing the WorkCentre 4118 / FaxCentre 2218 drivers and select [Have
Disk].

Browse to the required Windows NT driver on the CD and select [OK].

NOTE: The driver will be found on the appropriate PCL or PS CD, in the
Drivers>Print>ADDPrint folder. You will need to select the required language and operating
system. The driver is identified by the file extension .inf.
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Print Driver Installation for Networked Printers

5

6

Select [Next], and select [Next] again and the WorkCentre 4118 / FaxCentre 2218 driver
will be loaded onto the workstation.

> Enter the Printer Name and select [Next].

Select [Shared], select all the Windows NT V4.0 choices for the operating systems that
require access to the printer, and then select [Next].

A dialog box displays with a message regarding the printing of a test page.

Select [Finish] to accept the Yes choice.

» Continue with Test Print, see Test Print 8-16.

Windows 98/Me

1

NOTE: Prior to starting the setup procedure, download and install Xerox TCP/IP port
monitor driver from www.xerox.com.

> Access the Xerox website (www.xerox.com) and type WorkCentre 4118 / FaxCentre 2218
into the search box. Press [Enter].

> Select the download drivers link.
» Choose [Windows 98/Me] and select [Go].
> Scroll down and select [Xerox TCP/IP port monitor].

> When the file download screen appears, select [Run].

» Continue with Test Print, see Test Print 8-16.

Page 4-8
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Windows XP (Internet Printing Protocol)

NOTE: Windows XP supports printing via IPP as standard when TCP/IP is installed on a
Windows XP Workstation.

Use the Add Printer Wizard to add the WorkCentre 4118 / FaxCentre 2218 to the network.

>

>

DO @

o

Select [Start] and then select [Printers and Faxes].

Double-click on the [Add Printer] icon to display the Add Printer Wizard.

Verify that the [Network Printer] is selected and click [Next].

The [Locate Your Printer] screen displays.

Select [Connect to a printer on the Internet or on a home or office network].
The [Specify a Printer] screen displays.

In the URL field enter the IP address or hostname of the printer in the following format:
http://aaa.bbb.ccc.ddd or http://printer-host-name, where aaa.bbb.ccc.ddd is the IP
address of the WorkCentre 4118 / FaxCentre 2218 and printer-host-name is the host name
of the WorkCentre 4118 / FaxCentre 2218 registered with a DNS server.

The Add Printer Wizard will then ask if you wish to install a local driver for this printer. You
should click [OK] to install the driver.

Insert the CD containing the WorkCentre 4118 / FaxCentre 2218 drivers and select [Have
Disk].

Browse to the required Windows XP driver on the CD and select [OK].

NOTE: The driver will be found in the Drivers>Print folder on the CD in the appropriate PCL
or PostScript®3™ folder. The driver is identified by the file extension .inf.

o

Select [Next], and select [Next] again and the WorkCentre 4118 / FaxCentre 2218 driver
will be loaded onto the workstation.

A dialog box displays with a message regarding the printing of a test page.

Select [Finish] to accept the Yes choice.

Continue with Test Print, see Test Print 8-16.
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Print Driver Installation for Networked Printers

Windows 2000 (Internet Printing Protocol)

NOTE: Windows 2000 supports printing via IPP as standard when TCP/IP is installed on a
Windows 2000 Workstation.

Use the Add Printer Wizard to add the WorkCentre 4118 / FaxCentre 2218 to the network.

>

>

DO @

o

Select [Start], select [Settings], and then select [Printers].

Double-click on the [Add Printer] icon to display the Add Printer Wizard.

Verify that the [Network Printer] is selected and click [Next].

The [Locate Your Printer] screen displays.

Select [Connect to a printer on the Internet or on your intranet].

In the [URL] field enter the IP Address or hostname of the printer in the following format:
http://aaa.bbb.ccc.ddd or http://printer-host-name, where aaa.bbb.ccc.ddd is the IP
address of the WorkCentre 4118 / FaxCentre 2218 and printer-host-name is the host name
of the WorkCentre 4118 / FaxCentre 2218 registered with a DNS server.

The Add Printer Wizard will then ask if you wish to install a local driver for this printer. You
should click [OK] to install the driver.

Insert the CD containing the WorkCentre 4118 / FaxCentre 2218 drivers and select [Have
Disk].

Browse to the required Windows 2000 driver on the CD and select [OK].

NOTE: The driver will be found in the Drivers>Print folder on the CD in the appropriate PCL
or PostScript®3™ folder. The driver is identified by the file extension .inf.

o

Select [Next], and select [Next] again and the WorkCentre 4118 / FaxCentre 2218 driver
will be loaded onto the workstation.

A dialog box displays with a message regarding the printing of a test page.

Select [Finish] to accept the Yes choice.

Continue with Test Print, see Test Print 8-16.

Page 4-10

Xerox WorkCentre 4118 and FaxCentre 2218 System Administration Guide



Apple Mac OSX with Bonjour

» Ensure LPR/LPD is enabled on the WorkCentre 4118 / FaxCentre 2218.

> Insert the Drivers CD (compatible with PostScript®3™ , Macintosh, Linux) part number
705N00021.

> Double click on [Mac Installer] and follow the instructions.

> Go to [Printer Setup Utility] and click [Add]. Select [Default Browser] and select the
desired Bonjour printer from the list

All IP printers on the subnet will be listed.

> If not automatically selected, choose [Xerox] from the Print Using drop-down menu.

> Select [Xerox WorkCentre 4118 PS] or [Xerox FaxCentre 2218 PS] from the model list.

> Click the [Add] button.

If you have a Tray 2 option, then select [Tray 2] and click [continue].

> The Xerox WorkCentre 4118 / FaxCentre 2218 will now appear in the Printer List.

» Continue with Test Print, see Test Print 8-16.

PO D9 9§00
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Print Driver Installation for Networked Printers

Apple Mac OSX with AppleTalk

OD9O0DO@®

NOTE: These instructions assume the print driver is already installed.

To use AppleTalk, it must be enabled on your workstation and on the WorkCentre 4118 /
FaxCentre 2218. For instructions on enabling AppleTalk on the WorkCentre 4118 / FaxCentre
2218, refer to “Network Communication Setup” on page 5-3.

Use the instructions below to add a printer with AppleTalk.

> Select Go.

> Select [Utilities].

> Select [Printer Setup Utility] and click [Add].

> Select [Default Browser] and select the desired AppleTalk printer from the list.

> If not automatically selected, choose [Xerox] from the Print Using drop-down menu.

> Select [Xerox WorkCentre 4118 PS] or [Xerox FaxCentre 2218 PS] from the model list.

> Click [Add].

> If prompted, ensure the Installable Options are correct and click [Continue].

» Continue with Test Print, see Test Print 8-16.
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Apple Mac OSX with IPP

> Select Go.

> Select [Utilities].

> Select [Printer Setup Utility] and click [Add].

> Select IP Printer.

Select Internet Printing Protocol from the Protocol drop-down menu.

> Enter the IP Address of the WorkCentre 4118 / FaxCentre 2218 in Address.

> Select [Xerox] from the Print Using drop-down menu.

> Select [Xerox WorkCentre 4118 PS] or [Xerox FaxCentre 2218 PS] from the model list.

> Click [Add].

> If prompted, ensure the Installable Options are correct and click [Continue].

» Continue with Test Print, see Test Print 8-16.

OOOP9ODOEC
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5 AppleTalk

Introduction

This chapter explains how to install the WorkCentre 4118 / FaxCentre 2218 on an AppleTalk
network. The following information is provided:

» Information Checklist. ... ................... 5-2
> AppleTalk Installation. . . .................... 5-3
» Printer Driver Installation. .. ................. 5-6
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AppleTalk

Before starting the AppleTalk installation procedures, please ensure the following items are
available or have been performed:
Iltem By
An existing operational AppleTalk network with Macintosh workstation | Customer
computers equipped with Ethernet network interface cards are
required. These procedures are not designed to install an AppleTalk
network.
Macintosh System version 10.3+ Customer
Test the WorkCentre 4118 / FaxCentre 2218 to ensure it is installed Customer
fully and functioning correctly.
WorkCentre 4118 / FaxCentre 2218 Macintosh print and fax driver or | Xerox
PPD.
If problems are encountered during the WorkCentre 4118 / FaxCentre 2218 installation, refer
to the Problem Solving chapter for assistance.
Page 5-2
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AppleTalk Installation

Installation Procedure

There are three stages required to install the WorkCentre 4118 / FaxCentre 2218 on an
Appletalk network:

> Network Communication Setup

This requires the WorkCentre 4118 / FaxCentre 2218 to be setup for
Appletalk.

» Print Driver Installation

» Test Print

A test print should be submitted to ensure the WorkCentre 4118 / FaxCentre
2218 has been installed and configured correctly.

Network Communication Setup

@

This procedure is used to setup the network communication parameters of the WorkCentre
4118 / FaxCentre 2218.

At the WorkCentre 4118 / FaxCentre 2218, perform these steps:

HINT: Xerox CentreWare Internet Services can also be used to configure the WorkCentre
4118 / FaxCentre 2218, refer to the CentreWare Internet Services chapter for instructions.

» Connect the device to the network outlet or cable.

> Press the [Machine Status]
button.

—Machine Setup
Fax Setup

Xerox WorkCentre 4118 and FaxCentre 2218 System Administration Guide
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AppleTalk

@ > Press ¥ or A until System

Admin Tools displays and press
[Enter].

System Admin Tools
> If the System Admin Tools have [Passcode Protect]
been passcode protected, type in

the password and press [Enter].

> Press <€ or » until Network
Setup displays and press [Enter].

System Admin Tools
[Network Setup]

@ > Press <€ or » until Configure
Network displays and press

[Enter].

Network Setup
[Config. Network]

> Press <€ or » until AppleTalk
displays and press [Enter].

Config. Network
[AppleTalk]

> To enable or disable AppleTalk,
press <€ or » until the

required setting, [On] or [Off] AppleTalk
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NOTE: The WorkCentre 4118 / FaxCentre 2218 will attach itself to the default zone of the
local segment where it is connected.

@ > Install the Printer Driver (see “Printer Driver Installation” on page 5-6).
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AppleTalk

Printer Driver Installation
This section describes how to install the printer driver for the Mac OSX using the AppleTalk
protocol.
Installation Procedure
This section describes the procedures for installing the Mac print driver.
> Ensure the printer is on and that AppleTalk has been enabled (see “Network
Communication Setup” on page 5-3).
@ > Select [Printer Setup Utility] and click the [Add] button.
> Choose the WorkCentre/FaxCentre with the AppleTalk connection from the drop-down
menu.
All printers on the subnet will be listed.
9 > Choose Xerox WorkCentre 4118 PS or Xerox FaxCentre 2218 PS as the printer driver.
@ > Click the [Add] button.
@ » Continue with Test Print, see Test Print 8-16.
Setting the Printer Driver

When you finish installing the printer driver, set the PostScript Printer Description (PPD) file
for this machine to the printer driver.

The printer driver controls the functions of this machine based on the information in the PPD
file.

> Ensure the printer is on and that AppleTalk has been enabled (see “Network
Communication Setup” on page 5-3).
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> On the Apple menu select [Mac Print Utility].

This automatically searches for the printer.

> Select [Appletalk].

> Close the Mac Print Utility.

@0DD

» Choose the WorkCentre 4118 / FaxCentre 2218 driver.
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AppleTalk
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6 Advanced TCP/IP Setup

Introduction

This chapter explains how to change TCP/IP settings for your specific network requirements. The

following information is provided:

Enabling/Disabling Raw TCP/IP Printing

Y V. VY V¥V

Information Checklist. .. ....................
Enabling/Disabling LPR/LPD. ... .............

Enabling/Disabling HTTP . ..................
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Advanced TCP/IP Setup

Information Checklist

Before starting the TCP/IP installation procedures, please ensure the following items are
available or have been performed:

Item By

An existing operational network utilizing TCP/IP is required, these Customer
procedures are not designed to install a network.

Test the WorkCentre 4118 / FaxCentre 2218 to ensure it is installed Customer
fully and functioning correctly.

WorkCentre 4118 / FaxCentre 2218 print drivers. Xerox

If problems are encountered during the WorkCentre 4118 / FaxCentre 2218 installation, refer
to the Problem Solving chapter for assistance.
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Enabling/Disabling LPR/LPD

This procedure is used to enable or disable Line Printer Remote/Line Printer Daemon (LPR/
LPD) port on the WorkCentre 4118 / FaxCentre 2218. Once the port is enabled, you can
change the LPR port number.

To enable the LPR/LPD port, at the WorkCentre 4118 / FaxCentre 2218, perform these steps:

0 > Ensure the basic TCP/IP settings have been made (see “Basic TCP/IP Settings” on page
2-5).

> Press the [Machine Status]
button.

—>Machine Setup
Fax Setup

@ > Press ¥ or A until System

Admin Tools displays and press
[Enter].

System Admin Tools
> If the System Admin Tools have [Passcode Protect]

been passcode protected, type in
the password and press [Enter].

> Press <€ or » until Network
Setup displays and press [Enter].

System Admin Tools
[Network Setup]
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Advanced TCP/IP Setup

@ > Press <€ or P until Configure
Network displays and press

[Enter]. Network Setup
[Config. Network]

> Press <« or » until TCP/IP
displays and press [Enter].

Config Network
[TCP/IP]

> Press <€ or » until Manual
displays and press [Enter].

TCP/IP
[Manual]

> Press <€ or » until LPR/LPD
displays and press [Enter].

Manual
[LPR/LPD]

Page 6-4
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@ » To enable or disable LPR/LPD,
press <€ or » until the
required setting, [Enable] or

LPR/LPD
Disable] displays and press
{Emer]. ] displays and p [Enable]

@ > If the protocol is enabled, enter

the port number using the keypad

and press [Enter]. Enter Port No.
[0-65535]>515

NOTE: While you can change the port number at which the WorkCentre 4118 / FaxCentre
2218 will accept LPR print jobs, it is recommended that you do this ONLY with extreme
caution as most LPR spoolers are set to send print jobs to the default port number, 515. To
change Port number see “Using CentreWare Internet Services” on page 7-3.
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Advanced TCP/IP Setup

Enabling/Disabling Raw TCP/IP Printing

This procedure is used to enable or disable the Raw Printing port on the WorkCentre 4118 /
FaxCentre 2218. Once the port is enabled, you can change the Raw Printing port number.

NOTE: While you can change the port number at which the WorkCentre 4118 / FaxCentre
2218 will accept RAW print jobs, it is recommended that you use the default port, 9100. This
is the industry standard. To change Port number see “Using CentreWare Internet Services”
on page 7-3.

To enable the Raw Printing port, at the WorkCentre 4118 / FaxCentre 2218, perform these
steps:
0 > Ensure the basic TCP/IP settings have been made (see “Basic TCP/IP Settings” on page
2-5).

> Press the [Machine Status]
button.

—Machine Setup
Fax Setup

@ > Press Y or A until System

Admin Tools displays and press

[Enter]. System Admin Tools

> If the System Admin Tools have [Passcode Protect]
been passcode protected, type in
the password and press [Enter].
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> Press <€ or » until Network
Setup displays and press [Enter].

@ > Press <€ or » until Configure

Network displays and press
[Enter].

> Press <€ or » until TCP/IP
displays and press [Enter].

> Press <€ or » until Manual
displays and press [Enter].

System Admin Tools
[Network Setup]

Network Setup
[Config. Network]

Config Network
[TCP/I1P]

TCP/IP
[Manual]
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Advanced TCP/IP Setup

> Press <« or » until Raw
Printing displays and press

[Enter]. Manual
[Raw Printing]

@ » To enable or disable Raw

Printing, press <€ or » until

the required setting, [Enable] or Raw Printing
[Disable] displays and press [Enable]
[Enter].

@ > If the protocol is enabled, enter

the port number using the keypad

and press [Enter]. Enter Port No.
[0-65535]>9100

Page 6-8

Xerox WorkCentre 4118 and FaxCentre 2218 System Administration Guide



Enabling/Disabling HTTP

This procedure is used to enable or disable Hypertext Transfer Protocol (HTTP) on the
WorkCentre 4118 / FaxCentre 2218.

To enable HTTP, at the WorkCentre 4118 / FaxCentre 2218, perform these steps:

0 > Ensure the basic TCP/IP settings have been made (see “Basic TCP/IP Settings” on page
2-5).

> Press the [Machine Status]
button.

—Machine Setup
Fax Setup

@ > Press ¥ or A until System

Admin Tools displays and press
[Enter].

System Admin Tools
> If the System Admin Tools have [Passcode Protect]

been passcode protected, type in
the password and press [Enter].

> Press <€ or » until Network
Setup displays and press [Enter].

System Admin Tools
[Network Setup]
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Advanced TCP/IP Setup

@ > Press <€ or P until Configure
Network displays and press

[Enter].

> Press <« or » until TCP/IP
displays and press [Enter].

> Press <€ or » until Manual
displays and press [Enter].

> Press <« or » until HTTP
displays and press [Enter].

@ > To enable or disable HTTP, press
<€ or » until the required
setting, [Enable] or [Disable]
displays and press [Enter].

Network Setup
[Config. Network]

Config Network
[TCP/IP]

TCP/IP
[Manual]

Manual
[HTTP]

HTTP
[Enable]
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/ Network Installation Using
CentreWare Internet
Services

Introduction

This chapter explains how to enable and use the CentreWare Internet Services to install the
WorkCentre 4118 / FaxCentre 2218 on the network. The following information is provided:

> Information Checklist. . ..................... 7-2
> Using CentreWare Internet Services. .......... 7-3
> Accessing CentreWare Internet Services . ... ... 7-4
> Configuring the Network . ................... 7-5
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Network Installation Using CentreWare Internet Services

Information Checklist

Before starting the procedure for enabling the CentreWare Internet Services feature, please
ensure the following items are available or have been performed:

Item By

An existing operational workstation with TCP/IP Internet or Intranet Customer
accessibility is required. These procedures are not intended to install
the TCP/IP stack itself.

Obtain and record the following information: Customer

¢ A Unique IP Address:
* Gateway Address:
¢ Subnet Mask:

Refer to the Glossary for additional information on the Gateway
Address and Subnet Mask, if needed.

Test the WorkCentre 4118 / FaxCentre 2218 to ensure it is installed Customer
fully and functioning correctly.

Xerox CentreWare Internet Services. Xerox

If problems are encountered during the WorkCentre 4118 / FaxCentre 2218 installation, refer
to the Problem Solving chapter for assistance.
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Using CentreWare Internet Services

Introduction

CentreWare Internet Services uses the embedded HTTP Server on the WorkCentre 4118 /
FaxCentre 2218 to allow communication with the WorkCentre 4118 / FaxCentre 2218 if you
have a Web Browser with access to the Internet or Intranet. By entering the IP Address of the
WorkCentre 4118 / FaxCentre 2218 as the URL (Universal Resource Locator) in the Browser,
direct access to the WorkCentre 4118 / FaxCentre 2218 is available.

NOTE: Microsoft Internet Explorer version 4.x or later should be used. Other browsers may
work, but could produce unexpected results.

Many of the selections and settings needed to install WorkCentre 4118 / FaxCentre 2218 on
a network can be made using CentreWare Internet Services, eliminating steps that would
otherwise need to be performed at the WorkCentre 4118 / FaxCentre 2218 Control Panel.

Many of the features available within CentreWare Internet Services will require an admin user
name and password. A user will only be prompted for an admin name and password once in
a single browser session.

Before the CentreWare Internet Services feature can be used for installing WorkCentre 4118
/ FaxCentre 2218 on a network it must be enabled. There are three stages required to enable
CentreWare Internet Services:

» WorkCentre 4118 / FaxCentre 2218 is connected to the network.
» Enable HTTP on the WorkCentre 4118 / FaxCentre 2218.
» Avalid IP Address is defined for the WorkCentre 4118 / FaxCentre 2218.

Network Installation Using CentreWare Internet Services

NOTE: When making more than one configuration change please complete all the changes
in one go and then carry out a reboot.
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Accessing CentreWare Internet Services

0 » At a client workstation on the network, launch the Internet Browser.

> In the URL field, enter http:// followed by the IP Address of the WorkCentre 4118 /
@ FaxCentre 2218. Then select the [Enter] key.

Example: If the IP Address is 192.168.100.100, enter the following in the URL field:
http://192.168.100.100
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Configuring the Network

CentreWare Internet Services provides an alternative method of configuring the device

settings in order to successfully complete installation on a network.

Instructions are provided for configuring the device for the following network environments.

Refer to the appropriate instructions for the network being used:
Ethernet - page 7-6
AppleTalk - page 7-7
TCP/IP - page 7-9
SNMP - page 7-11

>

>

>

>

» SSDP - page 7-13

> LPRI/LPD - page 7-14
> Raw TCP/IP Printing - page 7-16
> IPP - page 7-18

>

HTTP - page 7-19
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Ethernet
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Use these instructions to set the rated speed for Ethernet using CentreWare Internet Services:

To complete the installation of the WorkCentre 4118 / FaxCentre 2218, perform these steps:

> Open CentreWare Internet Services (see Accessing CentreWare Internet Services on
page 7-4).

> At the CentreWare Internet Services Home Page for the WorkCentre 4118 / FaxCentre
2218, select the [Properties] tab.

> Select the plus symbol [+] to the left of the Connectivity folder in the Properties frame, and

then select the [+] symbol to the left of the Physical Connections folder.

> In the Properties frame, within the Physical Connections folder, select [Ethernet].

> Choose the appropriate [Rated Speed].

> Click the [Apply] button to implement any changes.

NOTE: Click the [Undo] button to cancel any changes made and return to the previous
values.

> Select the [Status] tab and then select [Reboot Machine] to enable the selection to take
effect.
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Use these instructions to install the WorkCentre 4118 / FaxCentre 2218 on an AppleTalk
network using CentreWare Internet Services.

Installation Procedure

There are two stages required to install the device on an AppleTalk network using CentreWare
Internet Services:

> Configure the WorkCentre 4118 / FaxCentre 2218

This procedure explains how to use CentreWare Internet Services to
configure the device.

> Test Print
A print job should be submitted to ensure the device has been installed and
configured correctly.

Configure the WorkCentre 4118 / FaxCentre 2218

To complete the installation of the WorkCentre 4118 / FaxCentre 2218, perform these steps:

> Open CentreWare Internet Services (see Accessing CentreWare Internet Services on
page 7-4).

> At the CentreWare Internet Services Home Page for the WorkCentre 4118 / FaxCentre
2218, select the [Properties] tab.

> Select the plus symbol [+] to the left of the Connectivity folder in the Properties frame, and
then select the [+] symbol to the left of the Protocols folder.

> In the Properties frame, within the Protocols folder, select [AppleTalk].

> Make the following selections and settings in the AppleTalk Physical Configuration section
of the Protocols frame:

Select the checkbox to enable AppleTalk.

Enter the [Printer Name]. Use a meaningful name, such as the location of the
device.

Choose the Zone where the printer resides from the drop-down menu.

> Click the [Apply] button to implement any changes.
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NOTE: Click the [Undo] button to cancel any changes made and return to the previous
values.

> Select the [Status] tab and then select [Reboot Machine] to enable the selections to take
effect.

» Continue with Test Print, see Test Print 8-16.
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Use these instructions to install the device on a TCP/IP network using CentreWare Internet
Services.

Installation Procedure

There are two stages required to install the device on a TCP/IP network using CentreWare
Internet Services:

> Configure the WorkCentre 4118 / FaxCentre 2218

This procedure explains how to use CentreWare Internet Services to
configure the device.

» Test Print

A print job should be submitted to ensure the device has been installed and
configured correctly.

Configure the WorkCentre 4118 / FaxCentre 2218

NOTE: The TCP/IP settings for the device will have been setup when completing the Open
CentreWare Internet Services section.

To complete the installation of the device, perform these steps:

> Open CentreWare Internet Services (see Accessing CentreWare Internet Services on
page 7-4).

> At the CentreWare Internet Services Home Page for the WorkCentre 4118 / FaxCentre
2218, select the [Properties] tab.

> Select the plus symbol [+] to the left of the Connectivity folder in the Properties frame, and
then select the [+] symbol to the left of the Protocols folder.

> Select [TCP/IP] and check the Protocol Configuration details are correct. If any of the
details are incorrect then enter the correct information.

> In the Physical Connection field, Ethernet will be the default setting.

Enter the [Host Name].
Choose the [IP Address Resolution] required.
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NOTE: DHCP automatically assigns IP addresses and is the default setting. If the IP Address
needs to be edited but is unavailable, select IP Address Resolution and then Static to
continue.

Enter the [Subnet Mask].
Enter the [Gateway Address].

> Check the DNS Settings details and if necessary enter the correct information required.

> Scroll down the screen and check the SLP Configuration details and if necessary enter the
correct information required.

> Click the [Apply] button to implement any changes.

NOTE: Click the [Undo] button to cancel any changes made and return to the previous
values.

> Select the [Status] tab and then select [Reboot Machine] to enable the selections to take
effect.

» Continue with Test Print, see Test Print 8-16.
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Use these instructions to configure the Simple Network Management Protocol (SNMP) using
CentreWare Internet Services.

Configure SNMP

To configure SNMP, perform these steps:

> Open CentreWare Internet Services (see Open CentreWare Internet Services (see
Accessing CentreWare Internet Services on page 7-4).

> At the CentreWare Internet Services Home Page for the WorkCentre 4118 / FaxCentre
2218, select the [Properties] link.

> Select the plus symbol [+] to the left of the Connectivity folder in the Properties frame, and
then select the [+] symbol to the left of the Protocols folder.

> Select [SNMP] and check the Protocol Configuration details are correct. If any of the
details are incorrect then enter the correct information.

> Make the following selections and settings in the SNMP Properties section of the frame:
Select the checkbox to enable the SNMP Protocol.
Click the [Edit] button to configure SNMP.
You can change the GET and SET Community Names.

NOTE: Changes made to the GET and SET Community Names will require corresponding
changes for each application that uses the protocol.

You can set the Default TRAP Community Name.

NOTE: This specifies the default trap community name for all traps generated by the
machine and can be overridden by the trap community name specified for each TRAP
destination address. It may not have the same trap community name as that specified for
another address.

You can Enable Authentication Failure Generic Traps to generate a trap for every SNMP
request received by the machine that contains an invalid community name.

> Click the [Apply] button to implement any changes and return to the first screen.
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NOTE: Click the [Undo] button to cancel any changes made and return to the previous
values.

> You can Add or Edit a Trap Destination Address by making the following selections and
settings in the Trap Destination Addresses section of the frame:

Click the [Add IP Address] button or the [Edit] button to add a new address or amend an
existing address.

In the IP Address Destination section, enter or amend the IP Address and UDP Port
Number.

In the Traps section, enter the Trap Community Name and check the boxes corresponding
to the required Traps to be Received.

> Click the [Apply] button to implement any changes and return to the first screen.

NOTE: Click the [Undo] button to cancel any changes made and return to the previous
values.

> You can Delete a Trap Destination Address from the Trap Destination Addresses section
of the frame:

Highlight the required Address/Socket or Port and click the [Delete] button.

> Click the [Apply] button to implement any changes.

NOTE: Click the [Undo] button to cancel any changes made and return to the previous
values.

> Select the [Status] tab and then select [Reboot Machine] to enable the selections to take
effect.
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Use these instructions to configure the Simple Service Discovery Protocol (SSDP) using
CentreWare Internet Services.

Configure SSDP

To configure SSDP, perform these steps:

> Open CentreWare Internet Services (see Accessing CentreWare Internet Services on
page 7-4).

> At the CentreWare Internet Services Home Page for the WorkCentre 4118 / FaxCentre
2218, select the [Properties] link.

> Select the plus symbol [+] to the left of the Connectivity folder in the Properties frame, and
then select the [+] symbol to the left of the Protocols folder.

> Select [SSDP] and check the Protocol Configuration details are correct. If any of the
details are incorrect then enter the correct information.

> Make the following selections and settings in the General section of the Protocols frame:
Select the checkbox to enable SSDP.
Enter the [Time to Live] (1 to 255 hops).

> Click the [Apply] button to implement any changes.

NOTE: Click the [Undo] button to cancel any changes made and return to the previous
values.

> Select the [Status] tab and then select [Reboot Machine] to enable the selections to take
effect.
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Use these instructions to enable or disable LPR/LPD using CentreWare Internet Services.

Installation Procedure

There are two stages required to install the device on a LPR/LPD network using CentreWare
Internet Services:

> Configure the WorkCentre 4118 / FaxCentre 2218

This procedure explains how to use CentreWare Internet Services to
configure the device.

» Test Print

A print job should be submitted to ensure the device has been installed and
configured correctly.

Configure the WorkCentre 4118 / FaxCentre 2218

To complete the installation of the device, perform these steps:

> Open CentreWare Internet Services (see Accessing CentreWare Internet Services on
page 7-4).

> At the CentreWare Internet Services Home Page for the WorkCentre 4118 / FaxCentre
2218, select the [Properties] tab.

> Select the plus symbol [+] to the left of the Connectivity folder in the Properties frame, and
then select the [+] symbol to the left of the Protocols folder.

> In the Properties frame, within the Protocols folder, select [LPR/LPD].

» Select the checkbox to enable LPR/LPD.

Enter the [Port Number].

NOTE: While you can change the port number at which the WorkCentre 4118 / FaxCentre
2218 will accept LPR print jobs, it is recommended that you do this ONLY with extreme
caution as most LPR spoolers are set to send print jobs to the default port number, 515.

> Click the [Apply] button to implement any changes.
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NOTE: Click the [Undo] button to cancel any changes made and return to the previous
values.

> Select the [Status] tab and then select [Reboot Machine] to enable the selections to take
effect.

> Using the procedure located in Section 4, Print Driver Installation for Networked Printers,
install the driver for the workstation.

» Continue with Test Print, see Test Print 8-16.

OJCOM
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Use these instructions to enable or disable Raw Printing using CentreWare Internet Services.

Installation Procedure

There are two stages required to install the device on an Raw TCP/IP printing network using
CentreWare Internet Services:

> Configure the WorkCentre 4118 / FaxCentre 2218

This procedure explains how to use CentreWare Internet Services to
configure the device.

> Test Print
A print job should be submitted to ensure the device has been installed and
configured correctly.

Configure the WorkCentre 4118 / FaxCentre 2218
To complete the installation of the WorkCentre 4118 / FaxCentre 2218, perform these steps:

> Open CentreWare Internet Services (see Accessing CentreWare Internet Services on
page 7-4).

> At the CentreWare Internet Services Home Page for the WorkCentre 4118 / FaxCentre
2218, select the [Properties] tab.

> Select the plus symbol [+] to the left of the Connectivity folder in the Properties frame, and
then select the [+] symbol to the left of the Protocols folder.

> Select [Raw TCP/IP Printing].
Select the checkbox to enable Raw TCP/IP Printing.

Enter the required port number.

NOTE: While you can change the port number at which the WorkCentre 4118 / FaxCentre
2218 will accept RAW print jobs, it is recommended that you use the default port, 9100. this is
the industry standard

> Click the [Apply] button to implement any changes.

NOTE: Click the [Undo] button to cancel any changes made and return to the previous
values.
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@ > Select the [Status] tab and then select [Reboot Machine] to enable the selections to take
effect.

6 » Continue with Test Print, see Test Print 8-16.
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Use these instructions to setup IPP using CentreWare Internet Services.

NOTE: The HTTP settings for the device will have been setup when completing the Enabling
CentreWare Internet Services section.

To complete the installation of the device, perform these steps:

> Open CentreWare Internet Services (see Accessing CentreWare Internet Services on
page 7-4).

> At the CentreWare Internet Services Home Page for the WorkCentre 4118 / FaxCentre
2218, select the [Properties] tab.

> Select the plus symbol [+] to the left of the Connectivity folder in the Properties frame, and
then select the [+] symbol to the left of the Protocols folder.

> Select [IPP].
Select the checkbox to enable IPP.

Check the IPP Configuration details are correct. If any of the details are incorrect then
enter the required configuration details in the appropriate boxes.

> Click the [Apply] button to implement any changes.

NOTE: Click the [Undo] button to cancel any changes made and return to the previous
values.

> Select the [Status] tab and then select [Reboot Machine] to enable the selections to take
effect.

» Continue with Test Print, see Test Print 8-16.
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Use these instructions to setup HTTP using CentreWare Internet Services.

NOTE: The HTTP settings for the device will have been setup when completing the Enabling
CentreWare Internet Services section.

To complete the installation of the device, perform these steps:

> Open CentreWare Internet Services (see Accessing CentreWare Internet Services on
page 7-4).

> At the CentreWare Internet Services Home Page for the WorkCentre 4118 / FaxCentre
2218, select the [Properties] tab.

> Select the plus symbol [+] to the left of the Connectivity folder in the Properties frame, and
then select the [+] symbol to the left of the Protocol folder.

> Check the HTTP Configuration details are correct.
Enter the [Keep Alive Timeout] in seconds from 5 to 99.

Enter the [Maximum Connections] from 5 to 32.

> Click the [Apply] button to implement any changes.

NOTE: Click the [Undo] button to cancel any changes made and return to the previous
values.

> Select the [Status] tab and then select [Reboot Machine] to enable the selections to take
effect.

» Continue with Test Print, see Test Print 8-16.
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8 Local Connection

Introduction

This chapter explains how to install the workstation drivers for local connection of the WorkCentre

4118 / FaxCentre 2218. The following information is provided:

YV V VYV V V

Information Checklist. . .....................
Installation Procedure . .....................
Installing Macintosh Drivers. . . ...............
Installing Windows Drivers . .................

Installing the Linux Print Driver . .............
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Local Connection

Information Checklist

Before starting the installation procedures, please ensure the following items are available or
have been performed:

Iltem By
IEEE 1284C Parallel Port Cable Customer
USB cable Xerox
Test the WorkCentre 4118 / FaxCentre 2218 to ensure it is installed Customer
fully and functioning correctly.
WorkCentre 4118 / FaxCentre 2218 drivers. Xerox

If problems are encountered during the WorkCentre 4118 / FaxCentre 2218 installation, refer
to the Problem Solving chapter for assistance.

NOTE: The installation procedures will install the WorkCentre 4118 / FaxCentre 2218 on the
host workstation. The procedure is not intended to connect the host workstation to other
workstations.
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Installation Procedure

The following drivers are provided PCLS6, Pos.tScript®:<}T"’I compatible, Macintosh PPD, Linux,
Scan and ControlCentre. You can install many of the drivers that you require at the same time.

Local Connection

NOTE: The drivers will be installed to the local port. For network connections, it is
recommended that you use the instructions relevant to the specific network requirements.

The WorkCentre 4118 / FaxCentre 2218 can be connected directly to the parallel port or USB
of a host workstation. A document file can be sent or received from the host workstation via
the appropriate port to the WorkCentre 4118 / FaxCentre 2218.

There are three stages required to install the WorkCentre 4118 / FaxCentre 2218 on a port on
a local workstation:

> Install the driver.
This requires the appropriate printer driver to be installed on the workstation.
> Workstation Setup

This requires the workstation to be configured to print to the WorkCentre
4118 / FaxCentre 2218.

» Test Print or Scan

A print job should be submitted to ensure the WorkCentre 4118 / FaxCentre
2218 has been installed and configured correctly.
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Local Connection

Installing Macintosh Drivers

Install the Print Driver
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> Ensure the printer is connected to the computer.

> Switch on the workstation and the printer.

> Insert the driver CD supplied with your PostScript®3™/Network kit.

> Double-click the CD icon that appears on the Macintosh desktop.

> Double-click the MAC _Installer folder.

> Double-click the MAC_Printer folder.

> The driver will be located automatically. If it is not, choose the WorkCentre 4118 /
FaxCentre 2218 driver from the [Print Using] list. Select [Add].

> Double-click the Xerox WorkCentre 4118 OSX or Xerox FaxCentre 2218 OSX icon.

> A window displays. Click [Continue].

> Select [install] to do Easy Install.

> Click [Quit] to finish.

To add a Printer

dOC

» Select Go.

> Select [Utilities].

> Select [Printer Setup Utility] and select [Add].
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@ » Select Xerox WorkCentre 4118 series or FaxCentre 2218 Series.

> The driver will be located automatically. If it is not, choose the WorkCentre 4118 or
FaxCentre 2218 driver from the [Print Using] list. Select [Add].
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Local Connection

Install the TWAIN Driver (scan)

COOORPIODO®

v Vv

Ensure the printer is connected to the computer.

Switch on the workstation and the printer.

Insert the driver CD supplied with your PostScript®3™/Network kit.

Double-click the CD icon that appears on the Macintosh desktop.

Double-click the MAC _ Installer folder.

Double-click MAC_Twain folder.

Double-click Xerox ScanThru installer.

Enter the password and click [OK].

Xerox ScanThru Installer window opens. Click [Continue].

Select [Install] to install the driver.

Click [Quit] to finish.

Select your preferred image editing program.

Select the WorkCentre 4118 / FaxCentre 2218 for importing documents.
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Installing Windows Drivers

Before printing, scanning or using ControlCentre with the WorkCentre 4118 / FaxCentre
2218, you will need to install a driver.

The procedure will install the driver and configure it for the local port.

FaxCentre 2218

0 » Insert the Xerox Drivers CD into the CD drive.

Within a few seconds, the CD should start automatically and present you with the opening
screen. If this does not happen, go to the [Start] menu, choose [Run] and browse to the CD
drive. Select setup.exe and click [Open]. Click [OK] to start the installation procedure.

@ > When the language selection window appears, select the appropriate language and click

[Next].
43 Xerox FaxCentre 2218 =3
[Engish =]
French
FaxCentre 2218
V20058
Newt> Cancel

> Choose the components you want to install and then click [Next]..
£ Xerox FaxCentre 2218 %]

Select components to install:

[IFCScan
[IPC Print
AContolCentie
OFCFax

FaxCentre 2218

If you wish to install a particular
software components, check the box
to the left of its name.

gk | [ Hew Cancel
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NOTE: You can choose to install as many drivers as you want by checking the appropriate
boxes.

> The confirmation screen summarizes your selections. Either click [Back] to reselect or click
[Next] to install your selections.
£% Xerox FaxCentre 2218 X

You have chosen to install:

PC5can
ControlCentre
PCFan

FaxContre 2218 )
Click the *Back’ buttan ta change the
software components you have
selected to install

<Back Mext> {Cancel

> When the setup has completed click [Finish]..

Xerox FaxCentre 2218

Setup has finished installing Xerox
FaxCentre 2218 on your computer.

FaxCentre 2218

> Switch off the printer and connect the Parallel or USB cable between the workstation and
the printer.

> Switch on the printer.

> Windows will automatically detect new hardware and install the appropriate driver.

> Continue with Workstation Setup.
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FaxCentre 2218/WorkCentre 4118 Series PS

0 » Insert the Xerox Drivers CD into the CD drive.

Within a few seconds, the CD should start automatically and present you with the opening
screen. If this does not happen, go to the [Start] menu, choose [Run] and browse to the CD
drive. Select setup.exe and click [Open]. Click [OK] to start the installation procedure.

@ > When the language selection window appears, select the appropriate language and click
[Next].

Hierox [X)

WorkCentre 4118
FaxCentre 2218

20058

Nexts Cancel

@ > Choose the components you want to install and then click [Next]..
2 Xerox [)

Select components to install:

[AReron W 4118 Series PS
erox FaxCentre 2218 PS

WorkCentre 4118 . 3 .
FaxCentre 2218 If you wish to install a particular

software components, check the box
to the left of its name

<Back | Next> Cancel

NOTE: You can choose to install as many drivers as you want by checking the appropriate
boxes.
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> The confirmation screen summarizes your selections. Either click [Back] to reselect or click
[Next] to install your selections.

You have chosen lo install.

T T -
[Mercu FaCertre 2216 PS5

WarkCeatre 4118 ) R
FaxCantrs 2218 Click the ‘Dack’ buton to change the
sultware components you have
selected o install

ok | Mew | [T |

@ > When the setup has completed click [Finish]..

Satwp has finished installing Xarox
FexCenlne: 2218femx WorkCenle
4110 Saries on your computer.

> Switch off the printer and connect the Parallel or USB cable between the workstation and
the printer.

> Switch on the printer.

> Windows will automatically detect new hardware and install the appropriate driver.

> Continue with Workstation Setup.

SO ®

WorkCentre 4118 Series

> Insert the Xerox Drivers CD into the CD drive.

@
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Within a few seconds, the CD should start automatically and present you with the opening
screen. If this does not happen, go to the [Start] menu, choose [Run] and browse to the CD
drive. Select setup.exe and click [Open]. Click [OK] to start the installation procedure.

@ > When the language selection window appears, select the appropriate language.

42 Xerox WorkCentre 4118 Series @

@ > Choose the appropriate radio button for the hardware purchased and then click [Next]..

[Engich =l

& ‘workCentie 4118, 4in1

© workCentie 4118, 2in 1

WorkCentre 4118 Series

W2 00.43

T e Cancel

> Choose the components you want to install and then click [Next]..
Select components to install,
e

[ L FirilFLL B)

B Contiolente

WorkContre 4118 Series

If you wish to install a particular
sultware components, check the box
to the left of its name.

ok | [ Mews Coreel |

NOTE: You can choose to install as many drivers as you want by checking the appropriate
boxes.
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> The confirmation screen summarizes your selections. Either click [Back] to reselect or click
[Next] to install your selections..

£2 Xerox WorkCentre 4118 Series [x)

‘You have chosen to install:

PC Scan
PC Prnt{PCL B)
ContrclCentie

WorkCentre 4118 Serios ]

Click the 'Back’ button to change the
software components you have
selected to install

<Back Nexty

> When the setup has completed click [Finish]..

Xerox WorkCenlre 4118 Series

Hertup has huished installing Xirox
WorkCentre 4118 Series on your
computer.

WorkCantra 8118 Series

> Switch off the printer and connect the Parallel or USB cable between the workstation and
the printer.

> Switch on the printer.

> Windows will automatically detect new hardware and install the appropriate driver.

> Continue with Workstation Setup.
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Workstation Setup

You will need to configure the printer drivers.

0 » Choose Printers and Faxes from Control Panel.

The location of this window will vary according to the operating system: from the

Start>Settings menu or directly from the Start menu.

The Printers and Faxes window displays.

Fle Edit Wiew Favorites Tools  Help

"% Printers and Faxes :

=101 x|

| &

\h) Back - J - l.ir’

1 -

/-. ) search ! Folders

5 3 X B |=

Address IC -y Prinkers and Faxes

x| B e |Links

Printer Tasks ¥ f:':é'

Adobe PDF Hero \WC
4115 Ser...

<

Other Places

jmy

. Xerox
Zerox WL 41138 Series PS EaxCentre
Documents: 0 2218PCLG
Status: Ready

Model: Xerox WC 4118 Series PS

b3

Details

NOTE: This window will have a different appearance according to the operating system of
the workstation. The window shown is from a Windows XP operating system.

@ > Click on the printer and choose Properties from the File menu or the right mouse menu.
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Local Connection

A properties window displays.

&; Xerox WC 4118 Series P5 Properkies f ﬂﬂ

General |Sharing| Parts I Advancedl Securityl Device Settingsl

Location: I

LComment:

Madel: Herox Wi 4118 Series PS

Features

Color: Mo Paper available:

Double-sided: Yes Letter ;I

Staple: Mo

Speed: 17 ppm

M axirmurn resolution: 1200 dpi LI
Frinting Preferences... | Print Test Page I

Ok I Cancel | Apply |

NOTE: This window will have a different appearance according to the operating system of
the workstation and the type of driver installed. The window shown is from a Windows XP
operating system.

> Click on the [Ports] tab.
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The Ports tab displays.

L: Xerox WC 4118 Series PS Properkties

2|

Genetall Sharing Forts |Advanced| Securit_l,ll Device Settingsl

-]
[ \g Heros W 4118 Series PS

FPrint to the Following port(z]. Documents will print to the first free
checked port.

Description Prirter

Prirter Port
O LPTZ  Printer Part
O com1: Serial Port
O comMz: Sesial Port
O coMz: Serial Part

O com4: Sedial Port hd|
Add Part... Delete Part Configure Part... |
¥ Enahle hidirectional suppart
[T Enable printer pooling
QK I Cancel Apply

9 > Check the box appropriate to the connection.

For a parallel connection, check LPT1, LPT2 or LPT3 depending on the configuration of

the workstation. This is usually LPT1.

For a USB connection, check the USB box.

@ > Click [OK].

@ » Continue with Test Print or Scan.
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Local Connection

Test Print or Scan

To ensure the WorkCentre 4118 / FaxCentre 2218 has been installed correctly a test print or
scan should be submitted from the workstation.

Test Print

Perform the following steps:

> Open a document on a client workstation.

> Select the device as the printer to which the selected document will be sent.

> Print the document on the device and verify that it prints correctly.

> Ensure the driver is installed on every workstation that will be sending jobs to the device.

> Repeat the test for all workstations that will be sending jobs to the device.

> The installation process is now complete.

If the test print fails, refer to the Problem Solving chapter for trouble-shooting procedures.

Test Scan

> Open the TWAIN compliant application used to scan documents.

» Place a document in the WorkCentre 4118 / FaxCentre 2218.

> Follow the instructions supplied by the scanning application and verify the job scans
correctly.

DO 99ODOC

If the test scan fails, refer to the Problem Solving chapter for trouble-shooting procedures.
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Installing the Linux Print Driver

Ensure you are logged in as "root" prior to starting the installation.

> Open the Unified Driver Configurator and click [Add Printer].
The Add Printer Wizard displays.

> Click [Next] to continue.
> Select the Manual Select radio button and click [Next].

Select the appropriate protocol and click [Next].

> Choose a name for the printer and provide the device location and description.

> Click [Next].

> Choose Test Printer to verify the install.

> Select [Finish] when complete.

909000

> Scroll to Xerox WorkCentre 4118 series (PS) or FaxCentre 2218 and click [Next].

A 2218 or 4118 series icon should now display in the Unified Driver Configurator.

Xerox WorkCentre 4118 and FaxCentre 2218 System Administration Guide
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9 Fax

Introduction

This chapter explains how to setup the Fax option. The following information is provided:

> Information Checklist. . .......................... 9-2
> Fax Setup using CentreWare Internet Services ....... 9-3
> Testing. ... 9-5
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5 Information Checklist

Lo

Before starting the installation procedures, please ensure the following items are available or
have been performed: Configuration can also be performed using Xerox CentreWare (Refer
to “Network Installation Using CentreWare Internet Services” on page 7-1).

Item By
Ensure the WorkCentre 4118 / FaxCentre 2218 is fully functioning Customer
prior to installation.
Ensure the WorkCentre 4118 / FaxCentre 2218 is connected to the Customer
telephone line.

If problems are encountered during the WorkCentre 4118 / FaxCentre 2218 installation, refer
to the Problem Solving chapter for assistance.
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Fax Setup using CentreWare Internet Services

Accessing CentreWare Internet Services
0 > At a client workstation on the network, launch the Internet Browser.

> In the URL field, enter http:// followed by the IP Address of the WorkCentre 4118 /
FaxCentre 2218. Then select the [Enter] key.

Example: If the IP Address is 192.168.100.100, enter the following in the URL field:
http://192.168.100.100
Fax General Setup

Use these instructions to set up fax using CentreWare Internet Services.

> Open CentreWare Internet Services (see "Accessing CentreWare Internet Services” on
page 9-3).

> At the CentreWare Internet Services Home Page for the WorkCentre 4118 / FaxCentre
2218, select the [Properties] tab.

> Select the plus symbol [+] to the left of the Services folder in the Properties frame, and
then select the [+] symbol to the left of the Fax Settings folder.

> Select [General] and verify the details. Update any incorrect information.

> Click the [Apply] button to implement any changes.

9000 &

NOTE: Click the [Undo] button to cancel any changes made and return to the previous
values.
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Fax Phone Book Setup

O RN

Use these instructions to set up the fax phonebook using CentreWare Internet Services.

> Open CentreWare Internet Services (see "Accessing CentreWare Internet Services” on
page 9-3).

> At the CentreWare Internet Services Home Page for the WorkCentre 4118 / FaxCentre
2218, select the [Properties] tab.

> Select the plus symbol [+] to the left of the Services folder in the Properties frame, and
then select the [+] symbol to the left of the Fax Settings folder.

> Select [Fax Phone Book] and verify the details. Update any incorrect information.

> You can add fax numbers individually; import these numbers from a comma delimited,
.CSV file; and export the number data from the WorkCentre 4118 / FaxCentre 2218 to a
comma delimited, .CSV file. You can also delete all numbers from the Fax Phone Book.

To Add a Number, choose either the Speed Dial or One-Touch Dial radio button; click the
[Add] button; choose the sequence [No.] and [Type] from the drop-down lists; enter the
[Name] and [Phone Number] including a [Charge Code] if required; and click the [Apply]
button.

To Import from a .CSV file, click the [Import from File] button and enter or Browse to the
location of the file.

To Export to a .CSV file, click the [Export to File] button and save the file to the required
location.

NOTE: For security purposes, charge codes (numbers entered after the '+ character) will
not be exported or imported, they will have to be re-entered manually.

To Delete all of the entries in the Phone Book, click the [Delete All] button and confirm the
deletions

> Click the [Apply] button to implement any changes.

NOTE: Click the [Undo] button to cancel any changes made and return to the previous
values.
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Testing

To ensure Fax has been setup successfully, perform the following steps:

Refer to the User Guide for full details of sending Faxes.

> Place a document in the Document Feeder, or on the Document Glass.
> Select the [Fax] key and set any features required.
> Enter Fax Number using keypad.

> Press the [Start] button to scan the original.

QOO @

If you loaded an original on the Document Glass, you will be asked if you want to scan
another page.

If the test job fails, refer to the Problem Solving chapter for trouble-shooting procedures.
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10 Administration Tools

Introduction

This chapter explains how to configure or use the various administration tools found in the
WorkCentre 4118 / FaxCentre 2218. The following information is provided:

> NetworkTools ........ ... ... ... .. ....... 10-2
> Maintenance using CentreWare Internet Services10-6
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Administration Tools

Network Tools

Three tools are provided for the network:
> Reset NIC - resets the network card after changes have been implemented.
> Factory Defaults- restores all settings to their factory state.

> Configure Network - provides walk-up configuration of network settings.

Reset NIC

To reset the network card:

0 > Press the [Machine Status]

button.

—Machine Setup
Fax Setup
@ > Press ¥ or A until System

Admin Tools displays and press

[Enter]. System Admin Tools
> If the System Admin Tools has [Passcode Protect]
already been passcode

protected, type in the password
and press [Enter].

> Press <€ or » until Network
Setup displays and press [Enter].

System Admin Tools
[Network Setup]
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> Press <€ or » until Reset NIC
displays and press [Enter].

> Choose Yes to reset the network
card.

Config Network

To configure the network:

> Press the [Machine Status]
button.

@ > Press ¥ or A until System

Admin Tools displays and press
[Enter].

> If the System Admin Tools has
already been passcode
protected, type in the password
and press [Enter].

> Press <€ or » until Network
Setup displays and press [Enter].

Network Setup
[Reset NIC]

Machine Setup
[Fax Setup]

System Admin Tools
[Passcode Protect]

System Admin Tools
[Network Setup]
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Page 10-3

Administration Tools



Administration Tools

9 > Press <€ or » until Config

Network displays and press
[Enter]. Network Setup
[Config Network]

NOTE: Refer to Section 2 Basic Network Installation and Section 6 Advanced TCP/
IP Setup for details on network configuration settings at the device.

Set Factory Defaults

To reset the factory defaults:

> Press the [Machine Status]
button.

—Machine Setup
Fax Setup
@ > Press ¥ or A until System

Admin Tools displays and press

[Enter]. System Admin Tools
> If the System Admin Tools has [Passcode Protect]
already been passcode

protected, type in the password
and press [Enter].

> Press <€ or » until Network
Setup displays and press [Enter].

System Admin Tools
[Network Setup]
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9 > Press <€ or » until Factory

Default displays and press
[Enter].

> Choose [Yes] to return to factory
default settings

Network Setup
[Factory Defaults]
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Administration Tools

Maintenance using CentreWare Internet

Services

Accessing CentreWare Internet Services

1
(2

» At a client workstation on the network, launch the Internet Browser.

> In the URL field, enter http:// followed by the IP Address of the WorkCentre 4118 /
FaxCentre 2218. Then select the [Enter] key.

Example: If the IP Address is 192.168.100.100, enter the following in the URL field:
http://192.168.100.100

Checking Printer Status

@ © OO0FC

Use these instructions to check the status of the WorkCentre 4118 / FaxCentre 2218, the
paper trays and consumables.

To check the status, perform these steps:

> Open CentreWare Internet Services (see “Accessing CentreWare Internet Services” on
page 10-6).

> At the CentreWare Internet Services Home Page for the WorkCentre 4118 / FaxCentre
2218, select the [Status] tab.
> Select [General] to view the status of the WorkCentre 4118 / FaxCentre 2218.

Click the [Reboot Machine] to apply any changes made within CentreWare Internet
Services to the WorkCentre 4118 / FaxCentre 2218.

Click the [Refresh] button to show the current status.

> Select [Trays] to view the status of the paper trays in the WorkCentre 4118 / FaxCentre
2218.

Click the [Refresh] button to show the current status.

> Select [Consumables] to view the status of the toner and drum in the WorkCentre 4118 /
FaxCentre 2218.

Click the [Refresh] button to show the current status.

Page 10-6

Xerox WorkCentre 4118 and FaxCentre 2218 System Administration Guide



Printing Reports

dOC

4

Use these instructions to print the printer’s reports or to send a test print file to the WorkCentre
4118 / FaxCentre 2218.

To print reports, perform these steps:

> Open CentreWare Internet Services (see “Accessing CentreWare Internet Services” on
page 10-6).

> At the CentreWare Internet Services Home Page for the WorkCentre 4118 / FaxCentre
2218, select the [Print] tab.
> Click the appropriate [Print] button to print:
System Data List
Network Configuration Sheet
PCL Font List
PS Font List

Fax Phone Book

> To print a test print file, enter the file name or [Browse] to the file location and select the
file.

Click the [Print] button in the Print-Ready File area.

Defining the Printer

QOO @

Use these instructions to change the printer’'s name and location.

To define the printer, perform these steps:

> Open CentreWare Internet Services (see “Accessing CentreWare Internet Services” on
page 10-6).

> At the CentreWare Internet Services Home Page for the WorkCentre 4118 / FaxCentre
2218, select the [Properties] tab.

> Enter the [Machine Name], but only if necessary.

> Enter the [Machine Location], if required.
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Administration Tools

®

6

> Click the [Apply] button to implement any changes.

NOTE: Click the [Undo] button to cancel any changes made and return to the
previous values.

> Select the [Status] tab and then select [Reboot Machine] to enable the selection to take
effect.

Checking Configurations

@ OO0

Use these instructions to check the configuration settings of the WorkCentre 4118 / FaxCentre
2218.

To check the configuration, perform these steps:

> Open CentreWare Internet Services (see “Accessing CentreWare Internet Services” on
page 10-6).

> At the CentreWare Internet Services Home Page for the WorkCentre 4118 / FaxCentre
2218, select the [Properties] tab.

> Select the plus symbol [+] to the left of the General Setup folder in the Properties frame.

> In the Properties frame, within the General Setup folder, select [Configuration].
The lower pane will show the firmware versions.

Click [Print System Data List] to print this report.

> In the upper pane, click the link for the settings that you want to check.

Page 10-8
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Checking Billing Counters

1
(2,
3
4

Use these instructions to check the billing and other counters of the WorkCentre 4118 /
FaxCentre 2218.

> Open CentreWare Internet Services (see “Accessing CentreWare Internet Services” on
page 10-6).

> At the CentreWare Internet Services Home Page for the WorkCentre 4118 / FaxCentre
2218, select the [Properties] tab.

> Select the plus symbol [+] to the left of the General Setup folder in the Properties frame.

> In the Properties frame, within the General Setup folder, select [Billing Counters].
The counters are displayed.

Click the [Refresh Counters] button to show the current status.

Making General Maintenance Settings

O® ©F

Use these instructions to set a number of maintenance items and to change the admin user’s
name and password.

To make general maintenance settings, perform these steps:

> Open CentreWare Internet Services (see “Accessing CentreWare Internet Services” on
page 10-6).

> At the CentreWare Internet Services Home Page for the WorkCentre 4118 / FaxCentre
2218, select the [Maintenance] tab.

Enter your [Admin User Name] and [Password].

> In the Maintenance frame, select [Maintenance].

> In the Maintenance area:
Enter the [Service Number] to call for service or advice.

Choose the required USB Mode, Ul Language, Power Save time and Clock Mode from the
drop-down lists.

Click the [Print] button to print an [Internal Cleaning Sheet].
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Administration Tools

6

7

> To change the admin login credentials, in the Change Administrator User Name and
Password area:

Enter the [New User Name] and [Old User Name].

Enter the [New User Password] and [Old User Password].

> Click the [Apply] button to implement any changes.

NOTE: Click the [Undo] button to cancel any changes made and return to the
previous values.

> Select the [Status] tab and then select [Reboot Machine] to enable the selection to take
effect.

Upgrading Firmware

990D O

Firmware upgrades may be supplied on a CD or as a download from the internet. Use these
instructions to install firmware upgrades in the WorkCentre 4118 / FaxCentre 2218.

To upgrade the firmware, perform these steps:

> Open CentreWare Internet Services (see “Accessing CentreWare Internet Services” on
page 10-6).

> At the CentreWare Internet Services Home Page for the WorkCentre 4118 / FaxCentre
2218, select the [Maintenance] tab.

Enter your [Admin User Name] and [Password].

> In the Maintenance frame, select [Firmware Upgrade].

> Insert the CD or download the upgrade from the internet.

> If not already selected, choose [Machine Firmware Download].

> Enter the file name and location or [Browse] to the location and select the file.

> Click the [Upgrade] button.
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Obtaining Assistance

QOO @

Use these instructions to obtain internet assistance and to record local assistance information
for the WorkCentre 4118 / FaxCentre 2218.

To obtain assistance and to edit the local settings, perform these steps:

> Open CentreWare Internet Services (see “Accessing CentreWare Internet Services” on
page 10-6).

> At the CentreWare Internet Services Home Page for the WorkCentre 4118 / FaxCentre
2218, select the [Assistance] tab.

> To obtain internet assistance for [Software Upgrades] and [Browser Software], click the
appropriate link in the Assistance frame.

> To edit the settings for local assistance, click the [Edit Settings] button.
Enter the details for the local [System Administrator] and the local [Xerox Support].

Click the [Apply] button to apply the changes.

NOTE: Click the [Undo] button to cancel any changes made and return to the
previous values.

If no changes were made, click the [Return] button to return to the Main Assistance page.
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11 Problem Solving

Introduction
This chapter explains the problem solving procedure and how to seek further assistance.

> Problem Solving Procedure. . ............... 11-2
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Problem Solving

Problem Solving Procedure

If a problem occurs with the WorkCentre 4118 / FaxCentre 2218 network printing or scanning,
this chapter is used to identify the steps to solve the problem.

Use the following procedure to identify and solve the problem:

> Resolve any local copier or fax problems first. Perform the corrective action that is
recommended by the User Guide. Do not attempt to resolve a network problem if the local
copier and fax functions are not operating correctly.

> Check that the WorkCentre 4118 / FaxCentre 2218 has power and it is turned on.

> Check that the network cable is connected to the WorkCentre 4118 / FaxCentre 2218.

> Check that the network cable is connected to the workstation.

Check that the WorkCentre 4118 / FaxCentre 2218 print driver is selected at the
workstation.

> Check that the software application being used to send print jobs is setup correctly.

> If available within the print driver, select the Print PostScript Error Information option or the
equivalent. If there are any PostScript®3TM errors, the document may not print, but an

error sheet will print if this option is selected. This error information can be helpful in
resolving the problem.

> Print the Connect Page and System Data List to check device settings.

> If a specific workstation is not printing then reload the device printer drivers on the
workstation.

OO 990D @

If all else fails, call the local Xerox Welcome Center where a representative will assist in the
diagnosis and solution of the problem.
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12 Glossary

10BaseT

ASCII

DHCP

DHCP AUTOIP

Driver

CSv

Ethernet

Ethernet Address

Fax Driver

Client Server

A cable used for networking. It is also called “twisted-pair” because it is comprised
of two insulated wires twisted together. 10BaseT cable can be shielded or
unshielded. Shielded cable provides more protection from noise than unshielded
cable.

An acronym for American Standard Code for Information Interchange. A coding
scheme that assigns numeric values to letters, numbers, punctuation, and certain
other characters.

An acronym for Dynamic Host Configuration Protocol. A protocol allowing the
principal parameters of network devices (including IP Addresses) to be configured
by central DHCP servers.

Available with Win98 and Win2000. Dynamic Host Configuration Protocol AutolP
will automatically assign itself an IP address in the range 169.254.x.x during
configuration of the PC.

Software that is loaded on the client workstation that prepares data to be sent to
the WorkCentre 4118 / FaxCentre 2218. It is also called a “print driver” or a “print/
fax driver”. The WorkCentre 4118 / FaxCentre 2218 drivers are designed
specifically for the WorkCentre 4118 / FaxCentre 2218

An acronym for Comma Separated Value. The CSV file is typically created by a
Third Party Email application, for example Microsoft Outlook.

Network transport technology commonly used to send data from one network
node to another.

The Ethernet Address is a unique address that identifies a device on a network.
The Ethernet Address is built into the device when it is manufactured. The
Ethernet Address consists of six bytes of information and is expressed as
hexadecimal numbers with the bytes separated by colons.

(Example: 00:00:08:D4:05:14)
See Driver.

A network environment in which the nodes communicate with a file server, and not
directly with other nodes.
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Gateway Address

HTTP

IEEE

IP
IP Address
ISO

LAN

Local Area Network
LPD

NetWare

NetWare Core
Protocol

Node

PCL

PCL5e

PCONSOLE

PDL

The Gateway Address is the IP Address of the gateway, or router, that the
WorkCentre 4118 / FaxCentre 2218 will use to access devices on other subnets.

An acronym for Hyper Text Transfer Protocol. This is the Internet standard that
supports the exchange of information on the World Wide Web (WWW). HTTP lays
the foundation for transparent access to the Internet.

An acronym for Institute of Electrical and Electronics Engineers. This is an
organization of engineering and electronics professionals notable for developing
the IEEE 802 standards for the physical and data-link layers of local area
networks, following the ISO Open Systems Interconnection (OSI) model.

See TCP/IP
See TCP/IP

An acronym for International Standards Organization. An international
organization that specifies network standards. The ISO developed the Open
Systems Interconnection (OSI) model.

An acronym for Local Area Network. This is a network that serves a relatively
small area, such as one building, and does not require telecommunications
services to reach all of the nodes.

See also WAN.

See LAN.

An acronym for line printer daemon. This is a print management program that
runs on a host.

A network operating system from Novell. Clients log onto one or more file servers,
which provide services such as mail, printing, and filing.

A protocol used by a NetWare client to request services from a NetWare server.

A device on a network that has an address and can send and/or receive data to
and from other devices on the network.

An acronym for Printer Control Language, which is used by Hewlett-Packard. This
is a set of commands that tell a printer how to print a document.

A Hewlett-Packard Printer Control Language (PCL) that is the first version of PCL
to support bi-directional communication between printer and computer.

A NetWare utility that can be used to create, configure, monitor, and manage
queues in a NetWare server, and to attach print servers to the queues.

An acronym for Page-Description Language. This refers to a programming

language, such as PostScript®3TM, that is used to describe output to a printer or a
display device, which then uses the instructions from the PDL to construct text
and graphics and create the required page image.

Page 12-2

Xerox WorkCentre 4118 and FaxCentre 2218 System Administration Guide



Peer-to-Peer

Print driver
Protocol

Queue

RJ45

Router

SAP

Server Advertising
Protocol

Subnet Mask

TCP/IP

Twisted-pair
WAN

Wide Area Network

A network environment in which the nodes communicate directly with other nodes.
Windows for Workgroups, NetWare Lite, and Macintosh System 7 are examples
of peer-to-peer networking products.

See Driver.
The rules that control the transmitting and receiving of data.

A place where jobs are stored temporarily, while they are waiting to be processed.
A print queue will hold several print jobs. A printer that is attached to the print
queue will print the jobs one at a time.

A connector used to connect a 10BaseT cable to a device.

A device that directs network packets to the segment of the network for which the
packet is intended, and excludes packets that are not intended for a segment.
Routers reduce unnecessary network traffic and control access to segments of
the network.

An acronym for Server Advertising Protocol. Nodes on a NetWare network
broadcast “SAP packets” at intervals to advertise their presence to other nodes.

See SAP.

There are approximately 4.3 billion different addresses in the IP Address range of
000.000.000.000 to 255.255.255.255. These addresses can be divided into
smaller, and much more manageable subnetworks, or subnets. The Subnet Mask
identifies which part of the IP Address contains the Subnet Address and which
part contains the host (or device) address.

An acronym for Transmission Control Protocol / Internet Protocol. TCP/IP is a set
of communications protocols that is supported by a variety of computer platforms.
TCP controls the data transfer and IP controls the routing of the data. The IP
Address is a unique address that identifies a device in a network. The IP Address
has to be set in the WorkCentre 4118 / FaxCentre 2218 by the System
Administrator. The IP Address consists of four bytes of information and is
expressed as decimal numbers with the bytes separated by dots.

(Example: 13.1.188.2)
See 10BaseT.

An acronym for Wide Area Network. This is a network that serves a relatively
large area, such as buildings in different cities and requires telecommunications
services to reach all the nodes. See also LAN.

See WAN.
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